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Section I - Introduction to ProviderLink  

1. What is ProviderLink? 
Unique to the healthcare industry is our interdependence on each other. Rarely can a job be 
performed without successful external communications. Before you can do your job, you must get 
an authorization, signature, order, medical record, referral, form, bed availability, etc. from 
someone else who typically does not report to you or even work for your organization. Herein lies 
the fundamental healthcare administrative problem. We are interdependent on each other but not 
necessarily accountable to each other.  

ProviderLink is an Internet communications tool that allows you to communicate patient information 
with other healthcare facilities or professionals. Instead of being tied to a particular fax machine or 
telephone extension, you can access ProviderLink anywhere you have an Internet connection. 

Any document, whether electronic or handwritten, or any other information about a patient can be 
placed in the patient record and securely sent to recipients. As long as the document can be 
printed or faxed, it can be added to ProviderLink and attached to a patient record.  

Whether the organizations you communicate with are online with ProviderLink or not, you can use 
ProviderLink to track any messages to or from them. For facilities that are online with ProviderLink, 
every message you send to them appears on their computer screen. If the facility is not yet online, 
you can still fax them messages and use ProviderLink's fax-back cover page to have any replies 
automatically routed back to the appropriate patient record. In either case, ProviderLink 
streamlines all of your communications. 

Whenever you are transmitting patient records, you should be concerned about security and 
HIPAA compliance. ProviderLink helps customers with their HIPAA compliance. Every message 
sent or received by ProviderLink is logged and is date/time stamped. You can see when a 
message is sent, when it was read, and who read it. All messages are patient specific, meaning 
they are logged with and follow the patient record. You will always be able to see the complete 
patient history in ProviderLink. The data stored in ProviderLink is secure and backed up several 
times each day. 
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2. Benefits of Using ProviderLink  
Each organization and each department within an organization has different communication needs 
and ProviderLink has features to address them all.  

Here are a few benefits current customers of different types have enjoyed since coming online with 
ProviderLink: 

Physicians  

a. Electronically request and receive patient information from other facilities 

b. Electronically request or provide signatures 

c. Electronically send referrals to other providers 

d. Create eForms to support practices workflows 

e. Electronically manage and store incoming faxes  

Hospitals 

a. Utilization Review 

b. Discharge Planning 

c. Business Office 

d. Electronically receive requests for medical records 
e. Outpatient Services 

Skilled Nursing Facilities 

a. Receive referrals from hospitals electronically 

b. Pager notification lets you know the moment a referral arrives 

c. Electronically receive and process Medicaid authorizations and prior approval 

d. Broadcast referrals to assisted living, rest homes, and other facilities 

HME/DME 

a. Manage physician signature collections for Certificates of Medical Necessity 

b. Electronically obtain Medicaid or private payor approval 

c. Electronically store Medicare DMERC forms 

d. Receive referrals from facilities electronically 

e. Pager notification lets you know the moment a referral arrives 

Payors 

a. Less time managing faxes and on the phone 

b. Create online authorizations and schedule upcoming reviews 

c. Copy clinical information into your other systems 
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3. Conventions Used In This Guide 
 

CONVENTIONS USED IN THIS SUPPORT MATERIAL 

Definition Example 

When introducing you to a new term, the term will appear in italics. eForms 

If you need to press a key on your keyboard, the text on the key will 
appear in a bold font. Press the Enter key. 

When you need to click a link or a button on the screen, the link or 
button name will appear in bold letters.  

Click the Submit 
button. 

When you are asked to use the menu bar, the instructions will include 
bold text and arrows.  Lookup > Facility 

A tip or important note providing helpful hints, requirements, or other 
important notes is indicated by the symbol to the right.  

 
Prerequisites 

It is assumed that you: 

 have been approved and set up in the Covisint portal 

 use Internet Explorer 7 

 
Icons and Notes 

The icons and notes used in the margins will lend you insight as to how you may best use the 
instructions as they are presented. 

Icon How The Icon Is Used 

 

The target icon points to a useful tip or hint that may help you use ProviderLink 
more efficiently. 

 

The Book icon helps to introduce an idea or concept for the first time. 
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How This Guide Is Organized 

 Section 1 – Introduction to ProviderLink - This section gives a basic overall introduction 
to ProviderLink and explains how to use this training guide to get the best results. 

 Section 2 – The Hands-On Tour of ProviderLink section outlines the basics of navigating 
through the ProviderLink system. You will apply the concepts you learn here throughout 
your day-to-day procedures. 

 Section 3 – The Using ProviderLink in Your Daily Work section describes how the 
features of the ProviderLink system work and how each department's users can get the 
most benefit from using them. 

 Section 4 – The appendix section describes how to troubleshoot issues encountered 
while using ProviderLink. 
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Section II - A Hands-On Tour of ProviderLink 

1. How Do I Access ProviderLink? 
ProviderLink is a browser-based web application, meaning it runs completely in an Internet 
browser requiring no additional hardware or software. You can access ProviderLink from virtually 
any computer as long as it is connected to the Internet. While ProviderLink may work in other web 
browsers, Microsoft Internet Explorer 7 is recommended. 

To Access ProviderLink: 
1. Using a computer that is connected to the Internet, open a Microsoft Internet Explorer (IE) 

window. 

2. In the IE window Address bar, type http://www.covisint.com/web/guest/login-healthcare and 
press the Enter key. The Covisint login screen will appear. 

3. Enter your User ID and Password. 

 

The Password is case-sensitive and, when you log in, you will need to enter it exactly as 
you set it up. The system will prompt you to change your Password every 90 days. 

4. Click Login. The Covisint Healthcare home page displays. In the left-hand menu, under 
Secure Applications, click ProviderLink to launch the application, which opens in a new 
window. 

Figure 1. Covisint Healthcare Home Page 
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A. Getting Help with ProviderLink 

There are a number of resources to assist you in using ProviderLink: 

 While you are logged in to ProviderLink, check the online help – click Help on the menu 
bar. 

 

 
 

Figure 2. Online Help Menu Option 

 Read the User Training Manual (this document). 

 Contact your facility administrator. 

 



   A Hands-On Tour of ProviderLink 

 

Page 11

2. Logging into ProviderLink  

A. The First Time You Log In 

After receiving email notification from your Security Administrator that you are registered, you must 
log in to ProviderLink to complete the registration process.  

1. Open Internet Explorer. 

2. In the URL address bar, enter http://www.covisint.com/web/guest/login-healthcare. The 
Covisint login screen displays. 

3. Enter your User ID and Password. 

4. Click Login. The Covisint Healthcare home page displays. 

5. In the left-hand menu, under Secure Applications, click ProviderLink to launch the 
application (see previous screen shot).  

a. The ProviderLink Terms and Conditions of User Agreements screen displays. 

Figure 3. Terms and Conditions 

6. Scroll down to the bottom of the screen and click Yes to accept the terms of the agreement. 
The ProviderLink News screen displays. 

7. Click Proceed to Application. You have now completed the registration process.  

8. When you log in, if you are a multi-facility domain, ProviderLink will ask you to select your 
facility. 

 

Figure 4. Choose a Facility 
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9. Next, you will choose a Work List View, which can be thought of as a caseload, or “in 
basket.” The Work List Views are listed alphabetically. Click the View drop-down arrow to 
select the work list you wish to view and then click the Submit button. 

 

 

 

 

 

 

 

 

Figure 5. Choose a Work List 

 
Note: “All Work Lists” is a special view that displays all of the patient records in all of the 
work lists. Generally, it is not used as part of a typical workflow. 

10. After selecting a Work List View, you will be taken to the Main Window, the list of patients in 
that work list. 

B. Failed Login 

The ProviderLink system is a secure system that only allows users who provide the right 
credentials to enter. In other words, you must provide a valid User ID and Password to successfully 
log into ProviderLink. If you mistype either of these, you will not be allowed to enter, and the 
system will display the failed login message, “You have entered an invalid password and/or User 
ID, please try again.” 

If you receive this message, check to make sure your User ID is spelled correctly. Then, re-enter 
your Password, keeping in mind that the Password is case sensitive.  

C. User Account Suspended 

If you enter an incorrect password 5 times within 5 minutes, your Covisint account will be locked 
due to an excessive number of invalid login attempts. As part of Covisint's comprehensive security 
design, accounts are automatically locked when it appears someone is trying to guess the 
password. 

In order to unlock your account, simply use your challenge question and answer to reset your 
password. This will automatically unlock your account. 

1. From the http://www.covisint.com/web/guest/login-healthcare page, click Forgot your 
password? 

a. The screen expands displaying a field to enter your User ID and then click Submit. The 
Reset Password screen displays. 

b. Enter the answer to your challenge question in the Challenge Answer field and click 
Submit.  
Note: You create your Challenge Question and Answer during the registration process. 
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c. Upon successful submission, the first half of the password displays on the screen, while 
the second half is sent to the email address you submitted during the registration 
process. 

2. Alternatively, you may contact your facility Security Administrator to request that he/she 
perform the password reset and unlock your account. 

3. A Look at the ProviderLink Window 
Once you successfully log into ProviderLink, you will see the patient list in the Main Window. You 
can think of this as the main “control panel” used to navigate throughout ProviderLink. The list of 
patients displayed on the Main Window can be considered your caseload, or the patients in your 
“virtual in-basket” with whom you are currently working. 

Figure 6. Main Window Patient List 

 Menu Bar – The Menu Bar at the top of the screen is the main navigation method to 
different parts of the ProviderLink system. 

 List Summary – This section gives an overview of the patients listed in the Main Window 
and displays a total of the Patients, Unread Messages, Tasks, and Reviews Due in your 
work list. 

 View Information – This section displays information about the current view, including the 
facility name, work list name, and the current user. 

 Patient List – This is the list of patients currently assigned to your work list, usually sorted 
by the patient's last name. You may re-sort the list by clicking on one of the column headers 
(i.e., ID, Reference, etc.) along the green column header row. Each row represents 
information about one of the patients in your work list, or a patient record. 

ProviderLink is a web-based application, and colored text usually indicates a hyperlink or link. Each 
link is a shortcut, and clicking on a link will take you to another page or section within ProviderLink. 
For example, clicking on one of the date links in the Documents column will take you to that 
patient's documents. If you’re not sure if text is hyperlinked, move your cursor over the text. 

Hyperlinked text will cause the cursor to appear as a pointing hand ( ). 

A. Understanding the Patient List 

The largest portion of the Main Window is the Patient List. The Patient List is divided into rows and 
columns: the horizontal rows represent a patient record; and the vertical columns represent data 
within each patient record.  
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Each of the fields in the Patient List is a link that you can use to navigate into different sections of 
the patient record. The table below lists the columns in the Patient List, what each column 
represents, and where the link leads when clicked: 

Column Represents Link Destination 

Message Icon  New message Create Message screen. Opens a 
new message that relates to this 
patient. 

Patient Patient name: last name, first name View Patient Information screen 

ID The Unique ID that helps your facility 
identify the patient. Most commonly used to 
display the medical record number. 

View Patient Information screen 

Reference A note that helps identify something about 
the patient record. See the description in 
the “Viewing Patient Information” section 
below. 

View Patient Information screen 

Tasks A reminder that some action needs to be 
taken regarding the patient record. 

Tasks for Patient screen 

Status Shows whether the patient has been 
admitted, discharged, etc. 

View Patient Information screen 

Auths Shows the latest payor authorization 
received for the patient. 

Authorization for Patient screen 

Next Review Shows when the next review is due. 
Examples, payor authorization, case 
management services review. 

Add/Edit Scheduled Task for 
Patient screen 

Unread Lists the number of unread messages 
received for the patient. 

Unread Messages for Patient 

Documents Lists the last date a document was added 
to the patient’s document folder. 

Documents for Patient screen 

As you become more familiar with ProviderLink's Main Window, you will learn shortcuts for 
navigating to the sections you wish to use by using the links in the various columns. 

B. Navigating the Main Window With The List Summary And Column Headers 

You may customize the information displayed on the Main Window using the links in the List 
Summary and the green column headers. By default, the Main Window will show you the list of 
patients in the work list sorted in ascending order alphabetically by the patient's last name.  

To change the content on the Main Window using the List Summary and Column Headers 
and Current View: 

1. From the Main Window, click the Unread Messages link. The Main Window content 
changes to display all of the unread messages with the most recent message at the top of 
the list. 

 

When you change the work list contents through a List Summary Link, the link turns 
green so that you will know what information is being displayed. 

a. You may change the list to display the oldest message first. Click the Date column 
header link. The list will refresh with the oldest unread message appearing first. 
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b. You may group messages by Sender. Click the From column header link. The message 
list will refresh with the Senders' names in ascending alphabetical order.  

2. You may wish to see all of the tasks that are pending for your work list. In the List 
Summary, click the Tasks link. The Main Window will refresh to display only the patients 
that have tasks pending. 

3. To view items that are overdue or pending, click the drop-down list to the right of Current 
View and select from the following options: 

a. Patient List - displays the patient list for the current work list (default option). 

b. Unread Messages List - displays a list of unread patient messages.   

c. Task List - displays a list of patient tasks.  

d. Reviews Due List - displays a list of patient reviews due. 

e. Overdue Unread Messages - displays a list of the overdue unread messages.**  

f. Message Needing a Reply - displays a list of received messages waiting on a reply that 
were sent to that mailbox.**  

g. Message Waiting on a Reply - displays a list of sent messages waiting on a reply that 
were sent from that mailbox. ** 

h. Overdue Review Task - displays a list of the overdue review tasks.**  

i. Overdue Reminder Task - displays a list of the overdue reminder tasks.** 

** Option only displays in the drop-down list if it has been activated by your Facility 
Administrator. 

4.  To return the Main Window to its original state, displaying all of the patients, click Patients 
in the List Summary. 
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4. Viewing Patient Information 
Now that you are familiar with the Main Window and its various uses, you may drill down to a 
specific patient record by accessing the View Patient Information screen. Each patient record can 
be considered a patient “folder” that stores all of the patient's messages, documents, and other 
vital information that relates to the patient. 

To View Patient Information on the View Patient Information Screen: 
1. From the Main Window, click a Patient Name link in the Patient column. The View Patient 

Information screen appears. 

Figure 7. View Patient Information 

2. The View Patient Information screen is divided into different sections. From this screen, you 
can access anything relating to this patient.  

a. The top section, also labeled “View Patient Information,” includes the patient's name, 
date of birth, and Social Security Number.  

b. The center section displays the work lists that are linked to this patient record. In other 
words, it shows which department or which staff member is working with this patient 
record. 

c. The bottom left section, the Status section, shows a brief overview what has happened 
with this patient record. 

 You can see when the patient was admitted or discharged. 



   A Hands-On Tour of ProviderLink 

 

Page 17

 You can see when the last payor review was received and when the next review is 
due. 

 More importantly, you will see how many tasks and unread messages are pending 
for this patient. 

 You may also access the patient's History Items and Audit Trail. 
d. The bottom right section, the Linked Mailboxes section, lists the mailboxes that are 

currently linked to this patient record. You may think of these linked mailboxes as 
message “speed dials” that allow you to create messages to send to these mailboxes 
quickly without having to search for them each time. 

 

To View Patient Documents: 
1. The menu bar on the View Patient Information screen includes functions (e.g., Save, 

Status, Authorizations, Documents, etc.) to other areas that hold information about the 
patient you are viewing. On the menu bar, click Documents. The list of documents stored 
with this patient record appears on the Documents screen.  

Figure 8. Document Folder Home 

2. To view a document: 

a. If the document is stored in one of the patient’s subfolders, click on the folder name in 
the Name column. The screen refreshes and displays all of the documents stored in the 
subfolder. Click the document name link in the Name column. The document displays. 

b. If the document is stored in the home folder, it appears on the screen after the 
subfolders (see “Fax From K. Miller” in the above screen shot), click its name link in the 
Name column. The document displays. 

To Move a Patient Document to a Subfolder: 
1. On the Documents screen, click the Move icon in the first column of the document you want 

to move. The Move Document screen displays 

2. Click the checkbox in front of the folder. 

3. Click Move.  

Note: In the first column, the folder icon indicates a subfolder. A patient record must have at 
least one subfolder to move a document from the “home” folder. See the next topic on how to 
create patient subfolders. 



A Hands-On Tour of ProviderLink 
 

   

Page 18

 

Figure 9. Move Document Item 

4. The Documents screen returns and the document is now stored in the selected folder. 

To Add New Patient Folders 
With ProviderLink, you can organize patient documents by creating subfolders. 

1. On the Documents screen, click New Folder on the menu bar. The Add Folders screen 
displays. 

2. Enter the following information: 

a. Folder Name 

b. Description 

3. To create more than one folder, click the More button. The application adds another blank 
row. Repeat Step 3b. 

Figure 10. Add Multiple Document Folders 

4. Click Save. The Documents screen returns displaying the newly added folder. 
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A. Navigating the Breadcrumb Trail 

The ProviderLink system does not use the Internet Explorer “Back” button to navigate back to other 
pages. Instead, there is a breadcrumb trail, a navigation tool that allows you to see where the 
current page is in relation to the path you took to get there. The term “breadcrumb trail” comes from 
the story of Hansel and Gretel, who left a trail of breadcrumbs as they walked through the forest so 
they could trace their way back home. In this same way, ProviderLink's breadcrumb trail acts as a 
“You Are Here” sign and shows you the path to get back to a previous screen. ProviderLink's 
breadcrumb trail is the set of links located near the top of the screen just below the menu bar  

You may trace your path back one-step at a time, or you may skip steps and jump back to a 
previous location earlier in the breadcrumb trail. For example, all breadcrumb trails will begin from 
the Main Window and clicking the Main Window link will return you to the Main Window. Clicking 
the Patient Name link in the breadcrumb trail will return you to the View Patient Information screen 

To use the Breadcrumb Trail to Navigate within ProviderLink: 
1. From an open eForm (or any other section of a patient record), click the Documents link to 

return to the list of documents. 

Figure 11. Navigation with the Breadcrumb Trail 

2. In the breadcrumb trail, click the Patient's Name link. You will return to the View Patient 
Information screen. 

3. Click the Main Window link in the breadcrumb trail. You will return to the Main Window. 
Notice the breadcrumb trail is a one-way path back to previous screens. To re-enter the 
View Patient Information screen, click the patient's name link. 

The breadcrumb trail is a powerful tool for navigating back to the screens you have already visited. 
After you become familiar with how the breadcrumb trail works, you will learn to use it to navigate 
more quickly throughout the ProviderLink system. 

B. Viewing a Patient's History Items and Audit Trail 

One of the foremost benefits in using ProviderLink for communication is that the system tracks 
every message sent or received regarding the patient in that patient's History Items. The patient's 
History Items screen will show you who the message is from, whom the message is addressed to, 
whether or not a message was sent successfully, when the message was sent, the message 
subject, and the number of documents attached to the message. If the recipient is also online with 
ProviderLink, you will see whether or not the recipient has read the message, when the message 
was read, and whether or not the recipient sent a reply. Clicking on the message subject link will 
open the message for you. 

If you need more detailed information about the history of the patient's record, you may view the 
patient's Audit Trail. The Audit Trail keeps an accurate record of not only a running history of the 
messages, but also the patient's documents, tasks, and the work lists linked to the patient record. 
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To view a Patient's History Items and Audit Trail: 

1. From the View Patient Information screen's Status section, click History Items. The 
Message History for Patient: screen appears.  

Figure 12. Patient Message History 

2. The Message History screen shows a complete history of any messages sent or received 
regarding this patient.  

3. By default, the message history is sorted by date and time with the most recent message at 
the top of the list. Like other lists you have seen, you may sort this list by clicking on the 
column header links. Click the From column header to sort the list by message sender. 

4. To return the list to its original state, sorted by date and time, click the History link in the 
breadcrumb trail. 

5. To view a more detailed history of the patient record, click Audit Trail on the menu bar 

6. The Audit Trail tracks the activities of the users who have been working with this patient 
record. You may use the column header links to sort the list by Date, User Name, Patient, 
or Audit Entry in order to find an entry more quickly. 

Figure 13. Patient Audit Trail 

7. Click Main Window in the breadcrumb trail to return to the Main Window. 

 

Neither the Message History nor the Audit Trail is editable, so you will always be 
assured an accurate record history from the time the patient record was created to the 
present time. 
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5. Changing Your Work List View 
ProviderLink allows you to view the work lists for other users within your facility. This enables you 
to check the status of a patient or access a patient's documents without having to wait for the user 
to send it to you. Also, if you are away from your workstation, another user may access your 
patients' information. You may also view patients in all work lists to get a summary of everyone in 
your system. 

To change your Work List View: 
1. From the Main Window, click the View: link in the View Information section in the upper 

right corner. The Choose Work List View screen appears. 

 

 

 

 

 

 

 

 

Figure 14. Change Your Work List View 

2. From the View drop-down list, choose the work list you wish to view. Click the Submit 
button. The chosen work list appears. 
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6. Working with Patient Records 
ProviderLink stores all messages and documents with their respective patient records. Before you 
can store a document or send a message, you will need to access an existing patient record or 
create a new one. 

Before creating a new patient record, you will want to prevent duplicating patient records by 
searching for existing patient records first. 

To search for a Patient Record: 
1. From the ProviderLink Main Window menu bar, click Lookup  Patient. The Patient Lookup 

screen appears. 

Figure 15. Patient Lookup Search 

2. Enter the criteria for which you wish to search, and click the Search button. The system will 
search your existing patient database for records that match your criteria. 

 

For the best search results, you may want to only enter the first few letters of the 
patient's name, or use the Unique ID. This way, you will still be able to find the patient 
record in case the patient's name is spelled differently in the record. 

3. If the system finds any patient records matching your criteria, you will see a list of matching 
records at the bottom of the Patient Lookup screen. 

4. If the system found the patient record you were searching for, click one of the blue links to 
access the patient's View Patient Information screen. 
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Figure 16. Patient Lookup 

5. If the system does not find the record you were searching for, the following message 
displays: “There were no patients found matching that criteria.” You may change your 
search criteria and try the search again. 

6. If you are unable to find the patient record, a record may not yet exist for that patient. To 
create a new patient record, click New from the Search Results menu bar to display the Add 
Patient screen. 

A. Creating a New Patient Record 

If no patient record exists, you will need to create one before creating any documents or sending 
any messages for that patient. 

To create a New Patient Record: 
1. From the ProviderLink Main Window menu bar, click New  Patient. The Add Patient 

screen appears. 
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Figure 17. Add a Patient 

2. Notice the required fields as noted with red asterisks (*). You must complete these three 
fields in order to successfully save your new patient record. Enter data in the required 
fields, at a minimum. 

 

Although the other fields are optional, it is generally a good idea to enter as much 
information as you have for each patient record. Later, when you create eForms for this 
patient, the system can use this data to populate the fields on the eForm. 

3. The optional Unique ID field is generally used to record the patient's medical record 
number or other identifier that uniquely relates to that patient. 

4. The Column Reference is also optional and is generally used to note something about that 
patient record. For example, you may use this field to remind yourself and your coworkers 
what is pending (e.g., “Placement pending”) or to note the patient's room number. 

5. It may be necessary to link your work list to this patient record so that, when you view your 
work list, this patient record will be included in the list. View the Linked Work Lists section in 
the center of the screen to ensure the desired work list appears in the right-most list box 
and will be linked. 

Figure 18. Link Work Lists to Patient 

6. When you are finished entering the patient's basic information and choosing the work lists 
to link, click the Save button to save the record. The patient record is saved and the screen 
refreshes to show you the saved patient record with more options. 
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7. Working with Messages 
Messages communicate information about patients. ProviderLink seamlessly connects you to 
electronic messages and fax messages 

When you send messages, ProviderLink automatically sends the messages to online contacts 
electronically and sends fax transmissions to fax contacts.  

Contacts reply to your messages in the same way they received them.  

 Online contacts can their reply in an electronic message that will be attached to the 
corresponding patient record.  

 Fax contacts can send their replies by fax. If they use the bar-coded, fax-back cover page, 
ProviderLink will convert the fax to an electronic message and attach it to the corresponding 
patient record.  

 

Check your incoming fax folder regularly to ensure you are aware of messages that were 
sent without a fax-back cover page. Fax messages sent without a fax-back cover page 
must be processed. For details, see “To Process an Incoming Fax,” below. 

A. Sending a New Message through ProviderLink 

A message contains patient-related communications you want to send to a contact using 
ProviderLink. When you send messages, ProviderLink sends them to the selected contacts 
electronically, or as faxes, depending on the contact communications requirements. 

To send a New Message through ProviderLink: 
1. Navigate to the associated patient's View Patient Information screen.  

2. Click Send Message from the menu bar. 

Figure 19. Send Message Menu Option 

3. The Create Message screen appears. Select the provider name from the To Recipients 
drop-down list. If the provider does not appear in the list, click Search to search for the 
facility. For more details about searching for facilities, see “To Process an Incoming Fax 
Message.”  
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Figure 20. Patient Create Message Screen 

4. The From Mailbox field is populated for you.  

5. Click the Browse button to select the documents you wish to attach.  

Note: If you are sending the message to a fax-only facility, only PDF or TIF documents can 
be attached. If you attach other file types, such as Word documents or Excel spreadsheets, 
a warning will display stating that this file type cannot be sent to a fax-only facility.  

6. Enter an appropriate Subject, which will appear on the fax cover page. For example, “OP 
Requisition.” 

7. You may enter a message that will appear on the fax cover page.  

8. Select reply options. 

 If you want the recipient to reply, click the Request a Reply check box.  

 If any of the recipients are not online contacts, select the Include Fax-Back Cover 
Page check box. A fax-back cover page will not be sent to online recipients. 

 Select the Create a Reminder Task check box if you want to be reminded you are 
requesting a response. 

9. Click Send. The message will be delivered to the recipients you specified. 

The following images illustrate how fax messages appear to recipients. 
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Figure 21. Fax With Fax-Back Cover Page 
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Figure 22. Fax Without Fax-Back Page 

B. Reading and Replying to Messages 

When patient related messages are send to you, whether they are sent electronically or by fax, you 
will read and respond to the messages through ProviderLink. ProviderLink will organize the 
messages for reading, and will maintain an audit and history trail of the messages.  

To Read and Reply to a Message: 
1. You can access messages from the Main window and from patient pages. This procedure 

assumes you are on the ProviderLink Main Window. On the Main Window, click Unread 
Messages. 

Figure 23. Unread Messages Menu Option 

2. The Unread Message screen displays, listing the messages with the oldest message 
appearing at the top of the list. 
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Figure 24. Unread Messages List 

3. Click the Subject link of the message you want to read. The View Message screen 
displays.  

Figure 25. View Message 

4. The View Message screen displays the related patient information, the message sender 
and recipient, when and how the message was sent, the message subject and text, and 
any document attachments. Also, you can see if the sender requested a reply. 

Read the message. Read each attached document by clicking its link in the Attached 
Documents window. When you click an attachment, follow your PC prompts to open it. 

Note that in the example, your reply is requested.  

5. Choose your response to the message. If you want to: 

 Reply to the message, click Reply on the menu bar. 

 Forward the message to another user or facility, click Forward on the menu bar.  

 Mark the message unread, so it is not removed from the Unread Messages List, click 
Mark Unread on the menu bar. You will return to the Unread Messages For Patient 
screen. After a message is read, you can still view it. See :To view a Patient's History 
Items and Audit Trail.” 

Continue these steps to reply to the message. 
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6. Click Reply on the menu bar. The Create Message screen displays, with the information 
from the original message. 

 

Figure 26. Create Message Screen 

7. Type your reply in the Message window and add any new attachments and recipients as 
required. For details, refer to “To send a New Message through ProviderLink.” 

8. Click Send to send your reply. 

C. Processing an Incoming Fax 

If you receive a fax message that does not use the ProviderLink fax-back cover page, you need to 
manually process the message and associate it with the correct patient. 

To process an Incoming Fax: 
1. If you are not viewing the Default Incoming Fax Folder screen, click the View ink, in the 

upper right area of the ProviderLink window. 

Figure 27. Main Window View Option 

2. On the Choose Work List View screen, select Folder – Incoming Faxes, then click 
Submit.  
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Figure 28. View Incoming Fax Folder 

3. The Incoming Fax Folder screen displays, similar to the following. 

Figure 29. Incoming Fax Folder 

4. From the Default Incoming Fax Folder screen, start processing the oldest fax message by 
clicking the Get Next Fax button. The first page of the fax message displays in the 
Document Viewer screen. 
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Figure 30. Document Viewer Screen 

5. Determine which provider the message is from, and click the Originator drop-down list to 
see if the provider appears. If so, select the provider. If the provider is not in the Originator 
list, click the Search button to bring up the Facility Search window. 

 

Figure 31. Facility Search 
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6. Enter the necessary criteria to search for the provider. If you do not enter search criteria in 
at least one field, the system will return all the available facilities in the search results. You 
can narrow the search results by: 

 Selecting a Facility Type from the drop-down list. 

 Entering partial or complete information in fields such as Facility Name, Last 
Name, etc. 

 Selecting a State and County 

7.  Click Search. The system will display the search results based on the criteria you 
specified. If the provider you are searching for does not appear, modify the search criteria 
and repeat the search. 

8. If the provider still does not appear, you may need to create the facility. See “To Create a 
New Fax-Only Facility.”  

9. If there are multiple pages, view each page to determine if the message contains 
documents for more than one patient.  

a. If all the message pages relate to one patient record, accept the default “ALL” value in 
the Page(s) field. 

b. If the message contains pages for more than one patient, click the More button to add 
another set of routing fields. Then, enter the appropriate page number or page range 
(e.g., 1-3) in the Page(s) field. 

Note: In the rows you add with the More button, modify the Pages, Document Name, 
Patient, and Mailbox fields as described in the following steps. 

10. Enter a logical name for the document in the Document Name field.  

11. Next to the Patient Name field, click Search. In the Patient Lookup window, enter patient 
search criteria and click Search. 

 

Figure 32. Patient Lookup Search 

12. Select a Patient for the fax by clicking the appropriate radio button in the search results 
window. Click Save. Note: If no patient record exists, you may need to create a new one.  
See “To Create a New Patient Record.” 
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Figure 33. Patient Search Results 

13. The Documents window for the selected patient displays. Select the check box for the 
folder for the message, and click Save.  

14. In the Document Viewer window, click the Mailbox drop-down arrow and select the Mailbox 
for the message. 

15. Depending upon the details of the message, you may be able to add additional information 
in “metadata” fields. For example, fields such as Status, Procedure Type, and Procedure 
Date may be available. Adding metadata will aid users who search for this document in the 
future.  

16. Once you have completed all of the required fields, you may choose how you wish to save 
the document(s).  

a. The “Remove document from fax queue” check box is selected for you automatically. 
This means that, when you choose one of the save options, the fax message will be 
removed from the list. Remove this check mark to leave the fax message in the queue. 

b. The “Save” button will process your routing options and return you to the same fax 
message for further processing. 

c. The “Save and Next button” will process your routing options, close the fax message, 
and open the next oldest one in the incoming fax folder. You will use this option most 
often when processing multiple fax messages. 

d. The “Save and Reply” button will process your routing options, close the fax message, 
and address an outgoing message to the sender of the fax. This enables you to request 
additional information from the fax originator. 
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8. Managing Documents 
ProviderLink enables you to store patient-related documents with each patient record. Any 
document that is sent to you online or faxed into the system can be added to a patient's record. 
You can also use the online eForms function in ProviderLink to create documents. In addition, 
virtually any hard copy, paper document, or any report you can print to a local printer can be added 
to a ProviderLink patient record and be sent in a message to another facility. 

A. Adding Documents to a Patient Record — Virtual Printer 

You can add any document you can open from your computer to a patient record with 
ProviderLink’s Virtual Printer feature.  

Note: Please verify the Virtual Printer driver is installed on your PC before you attempt to add 
documents to patient records as described below. For help troubleshooting the Virtual Printer, see 
Appendix A, “Documents Management.” 

To add Documents to a Patient Record with the Virtual Printer: 
1. From the View Patient Information screen's menu bar, click Documents. The Documents 

Folder screen displays. 

Figure 34. Documents Menu Option 

2. On the Documents Folder screen, click Add Document on the menu bar, and then select 
Add By Print Job from the drop-down list. 

Figure 35. Add Document Menu Options 

3. The Print Attach window displays. Type a logical name in the Document Name field. 
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Figure 36. Print Attach, Document Name 

4. Click Print. The Print Now window appears and the system is ready to receive the 
document. Do not close the Print Now window. 

5. Without logging out of ProviderLink, open the document you want to add to the patient’s 
record.  

6. Use the application with which you opened the document to navigate to its print menu. For 
example, click File>Print, then select ProviderLink Printer from the list of printers. Click 
OK. 

 

Figure 37. Print to ProviderLink Printer 

7. The ProviderLink Internet Gateway window will appear and the document will be sent to the 
patient record. When you see “The send completed successfully” message, click the 
window’s Close button. 
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Figure 38. ProviderLink Print Success Indicator 

8. Return to the Print Now screen and click Close. 

9. Return to the Documents Folder screen that opened at step 2. The document you added 
appears in the list. 

 

Figure 39. Document Folder with Added Document 

10. You can: 

 Click the Document Notes icon to add notes about the document. 

 Click the Move icon to move the document to a different folder. 

 Click the Document Name link to view the document to verify it was added successfully. 

B. Adding Documents to a Patient Record — Hard Copy/Fax 

If you have a hard copy of a document, you can add it to a Patient Record, using the ProviderLink 
fax feature. 

To add Documents to a Patient Record with Hard Copy and Fax: 
1. From the Patient Information screen's menu bar, click Documents to view the patient’s 

Documents Folder screen. 
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2. On the menu bar, click Add Document  Add By Fax. The Fax Attach screen appears. 

3. Type a logical name in the Document Name field. 

Figure 40. Add Document, Fax Attach 

4. Click Print on the menu bar or the Print button. The system will generate a bar-coded 
cover page. 

 

Figure 41. Fax-back Cover Page 

5. Click Print on the menu bar to display the print options. Print the cover page on your 
printer. 

6. After the cover page prints, click Close on the menu bar to close the cover page and return 
to the Documents Folder screen. 

7. Once the cover page prints, place it on top of the hard copy documents (maximum of 40 
pages, not counting the cover page) and fax the package to the number indicated on the 
cover page. After the fax sends successfully, the document will be listed on the Documents 
Folder screen (this screen may need to be refreshed). 

8. You can: 

 Click the Document Notes icon to add notes about the document. 

 Click the Move icon to move the document to a different folder. 

 Click the Document Name link to view the document to verify it was added successfully. 
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C. Adding Documents to a Patient Record — eForms 

EForms are electronic versions of commonly used healthcare forms. EForms can include the 
capabilities to check for errors, to validate entries, and to ensure required fields are completed prior 
to saving.  

EForms can be added to a patient's record, printed or sent to another facility for review or signature 
via ProviderLink. 

You can work with available eForms, and you can work with a Facility Administrator to create new 
eForms to help automate your workflows. 

Important: Only a ProviderLink Facility Administrator can add or maintain eForms for your facility. 
If there are no eForms created for your facility, the eForms menu options described below will not 
display on your ProviderLink Document Folders windows. 

To add Documents to a Patient Record with eForm: 
 

1. From the View Patient Information screen, click Documents on the menu bar. The 
Document Folder screen displays. 

2. Click eForms, and then select the appropriate eForm from the drop-down list.  

 

Figure 42. eForms Menu Options 

3. The eForm displays. The following eForm screen shot is provided for example only, and 
may not match a form on your facility. 
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Figure 43. Medical Records Request 

4. Complete the form as required. 

5. Click Check to verify there are no errors in your form. If there are errors, correct them and 
repeat this step. 

6. Select one of the following Save options: 

 Click Save periodically to save the eForm as you are completing it.  

 Click Save and Send to send the form as an attachment to a message. For details 
about the Create Message window, see “To send a New Message through 
ProviderLink.” 

 Click Save and Close to close the form and return to the Documents section. 

Note: If you do use the Save and Close option, the eForm is added to the patient 
record. If the eForm is an information-requesting form, you will need to open it later and 
use the Save and Send option to send it to the appropriate facility. 

7. When you click Save and Close or complete the Save and Send process, the Documents 
Folder screen displays, with the eForm attached to the patient's record. You can click the 
document name to open it. When opened, you can use the options on the menu bar to 
attach the eForm to a message, print it, send it for signature, or create a copy. 
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9. Managing Contacts 
With ProviderLink, you can exchange information with online facilities (other ProviderLink users) 
and fax-only facilities. Online facilities become available for information exchange as they join 
ProviderLink. You can add fax-only facilities as required by your business needs. Once you create 
fax-only facilities, you can exchange information with them through ProviderLink.  

There are two steps to the process for managing fax-only contacts: 

A. Create a fax-only facility. 

B. Add one or more contacts to the facility. 

A. Creating a Fax-Only Facility 

Create a fax-only facility to enable information sharing with an entity that is not already a 
ProviderLink facility. 

To Create a Fax-Only Facility: 
1. From the Main Window, click New > Facility.  

Figure 44. Lookup > Facility Menu Option 

2. The Add Fax Facility screen displays. Enter the name of the provider in the Fax Facility 
Name field, which is the only required field. 
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Figure 45. Add Fax Facility 

3. Enter the: Main Phone Number; City; State/Province; Zip; and County, as required. 

4. Choose the type of provider from the All Facility Types list box and click Select. There may 
be more than one applicable provider type. If you add a facility type and want to remove it, 
highlight the facility type and click Unselect. 

5. Check your entries for accuracy, and click Save. The Facility Contact Information screen 
displays. 

 

Figure 46. New Facility, Contact Information 

Note: At this point you have created a fax-only facility, but the facility is not yet ready for use with 
ProviderLink. To complete setting up the facility, see “Add Contacts to a Fax-Only Facility.” 
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B. Add Contacts to a Fax-Only Facility 

Adding contacts to a fax-only facility sets it up for information exchange through ProviderLink. 
Before you can add contacts, you must create the associated facility. See “To Create a Fax-Only 
Facility.” 

After you successfully complete this procedure, the fax-only facility will become available for use 
with ProviderLink for tasks such as sending and receiving messages. 

Important: If you cannot access the ProviderLink menus described in this procedure, then you do 
not have the permissions required add contacts. In such cases, you can: 

 Request your domain or facility administrator to add the contacts. 

 Request the required administrator permissions for your ProviderLink account. 

 
To Add Contacts to a Fax-Only Facility:  

1. From the Main Window, select Lookup > Facility. The Facility Search screen displays. 

2. Enter search criteria as required to search for the fax-only facility you previously created. 
Click Search. The results display at the bottom of the screen. If your facility is not listed, 
modify your search criteria and search again. 

 

Figure 47. Fax Facility Search 

3.  In the search results, click the name of the facility to which you want to add a contact. The 
Facility Contact Information screen displays. 

4. On the Facility Contact Information screen, click Add Contact. The Contact Mailbox 
Information screen displays.  
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Figure 48. Add Contact to Fax Facility 

5. Complete the fields as required and click Save. 

Note: Enter values for Last and First names, add the fax number and verify the Active 
check box is selected. If you miss any required values, when you click Save, the system will 
prompt you to enter the needed information. 

6. When the new contact is successfully saved, the Facility Contact Information screen 
displays, with the contact link near the bottom of the screen. 

 

Figure 49. Facility Contact Information 

Once you see the Facility Contact Information screen display with at least one contact listed, the 
new fax-only facility is ready to use with ProviderLink. 
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10. Logging Out of ProviderLink 
When you are finished working in ProviderLink, you should end your ProviderLink session. Logging 
out is important, especially if you share a computer with other users. This creates an accurate 
message history and audit trail by ensuring that the user ID logged in is actually the user who is 
working in the system. 

To log out of ProviderLink: 
1. From virtually any view, click Logout on the menu bar. 

 

Figure 50. Logout Menu Option 

2. The system will log you out, show you a log out confirmation screen, and after a few 
seconds, returns you to the ProviderLink Login screen. 

A. Automatic Logout 

ProviderLink also has an automatic logout feature. For security reasons, the system will log you out 
after a designated period of inactivity. In other words, if the ProviderLink system determines that 
you have not changed or refreshed a screen within this timeframe, the system will log you out and 
return to the main ProviderLink Login screen. Login to ProviderLink again. 
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Section 2 Summary 
After this hands on tour through the ProviderLink system, you should now know: 

 what to do if you are unable to log into ProviderLink 

 what appears on the Main Window and how the Patient List is organized 

And how to: 

 access the ProviderLink system 

 log into ProviderLink 

 view Patient information 

 move Patient documents 

 create Patient folders 

 use the breadcrumb trail to navigate within ProviderLink 

 view a patient's History Items and Audit Trail 

 change your Work List view 

 look up and create patient records 

 process, send, and receive messages 

 add documents to patient records via fax, virtual printer, and eForms 

 manage fax-only facilities and contacts 

 log out of ProviderLink 
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Section III - Using ProviderLink In Your Daily Work 

1. Transitioning from Paper to Electronic Communications 
ProviderLink brings structure and accessibility to healthcare communications. ProviderLink 
messages are automatically associated with the related patient record. All communications are 
time and date stamped and comprise an audit trail that both senders and recipients (if they are 
online, rather than fax contacts) can view.    

A. Benefits of Transitioning to Electronic Patient Communications 

Transitioning from paper to electronic communications within the framework of ProviderLink 
provides significant benefits to patients and healthcare institutions and practitioners: 

 Information is entered one time, electronically, and associated with a patient record 

o Audit and history trail of documents, dates, and staff 

o Reduced time to find information 

o Reduction of handwriting errors 

o Reduction in transcription errors  

 Informed decision making through a comprehensive view of all ProviderLink inputs to a 
patient record 

o Aggregates patient information from other healthcare institutions 

o Helps physicians avoid replicated tests and procedures 

o Reduces reliance on patients’ memory of current and past tests, medications, and 
procedures 

 Information is readily available whenever it is needed 

 Rapid transfer of information regarding referral requests, information requests, 
prescriptions, etc., with other healthcare facilities without telephone calls, voice messages, 
manual faxing, etc. 

 Customizable to support your organization’s workflow and business needs 

 Supports compliance with healthcare industry regulations for electronic record keeping 

ProviderLink also makes it easier to transition to electronic communications by providing fax and 
virtual printer capabilities that help your organization get existing paper records into the system. 

B. Understanding Workflow Support in ProviderLink 

When you use ProviderLink, you are working in an environment that was set up to support the kind 
of work you do in a general way. Once you understand how ProviderLink can be customized, it is 
relatively easy to set up work lists and eForms that add efficiencies to your practice.  

The following high level topics are designed to help you better understand how to customize 
ProviderLink to better support your practice’s workflow and information needs: 

 Assessing your workflow 

 Analyzing work lists 
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 Identifying needed eForms  

 

Assessing Your Workflow 

To decide how to customize ProviderLink, you need to verify your understanding of the workflows 
performed by the various staff groups in your office. It helps to document your understanding, at 
least at a high level. You can document workflows at a high level by: 

 Listing each work role in your organization, even if that role is not a full time assignment. 
For example, work roles could include: 

o Doctor 

o Nurse Practitioner 

o Physician’s Assistant 

o Office Manager 

o Receptionist 

 Making a simple diagram of how patients move through your organization. For example, 
patients might: 

o Check in with a receptionist 

o Go to a station for collection of commonly-monitored attributes such as weight, 
blood pressure, etc. 

o Move to an office where more information is collected about symptoms or the visit 
reason 

o See a doctor, and receive medications, prescriptions, referrals, or other treatment 
instructions 

o Meet with the office manager to resolve charges and schedule appointments 

 

Once you have documented the work that’s done and the process you use to assess and treat 
patients, you can move to the next step. 

Analyzing Work Lists 

Work lists have general and ProviderLink-specific definitions. They can be: 

 Lists of tasks performed by the various roles in your organization 

 ProviderLink work categories available from the Choose Work List View screen 

ProviderLink work list categories can be used to group patient-related tasks associated with the 
work roles you identified in Assessing Your Workflow, above. 

When you use work lists in this way, patient interactions are recorded by staff in various work roles. 
The patient information moves through the ProviderLink work lists, as the patient-related work 
moves from one role to another. For example, when a patient enters your organization: 

 A receptionist might record updated information in a form available with the Receptionist 
work list, and then move the patient to the Nurse Practitioner work list. 

 The Nurse Practitioner might record patient vital statistics and symptoms in forms available 
with the Nurse Practitioner work list, then move the patient to the Doctor work list. 
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 The doctor might record prescriptions, referrals, or other treatment options in forms 
available with the Doctor work list, then move the patient to the Office Manager work list. 

 The Office Manager might record information about charges in a form available with the 
Office Manager work list. 

When all the patient-related communications are completed, the responsible role removes the 
patient from all work lists. This does not remove the patient’s information, it just indicates there is 
no outstanding activity for the patient. 

Customizing Work Lists 

To customize ProviderLink work lists, you need to understand: 

 Your organization’s roles, workflow, and work tasks 

 The ProviderLink work lists that are already available to your facility 

If the existing work lists meet your organization’s needs, then no customization is required. 

If your organization would benefit from customized work lists, you will work with your ProviderLink 
facility administrator, who will create and manage the work lists for you. 

If you need customized work lists, you may also need eForms that are not available to your facility. 
An overview of eForm creation and management is provided in the following section. 

C. Creating and Managing eForms 

Sections A and B above provided overviews of how you could collect information about your 
organization’s roles and processes. This section provides an overview of how to better transition to 
electronic communications by adding eForms that will meet your organization’s workflow and 
information needs to your facility. 

An eForm is an electronic form. You can create eForms to collect the same information you are 
currently collecting in paper forms, spreadsheets, etc. When information is collected in an eForm it 
is automatically attached to the patient’s record – no transcribing or data re-entry is required. You 
can even design eForms to send to other healthcare facilities to collect or provide information in 
the desired structured format. 

Important: Only ProviderLink domain or facility administrators can create and manage eForms. 
The purpose of this section is to help you better understand how to work with the person who will 
create and manage your eForms. For details about eForms creation and management, refer to the 
ProviderLink Facility Administrator Manual. 

First, you should determine if you need to create eForms. Review the eForms already available on 
your ProviderLink facility, and determine if additional eForms are required. If additional eForms are 
required, you will need to know the following information to effectively communicate with your 
ProviderLink facility administrator: 

 What work task will the eForm support? 

 Who will use the eForm? 

 What information must be included in the eForm? Do you want the eForm to validate data 
such as telephone numbers or dates are in the correct formats? 

 Which information in the form is required? 

 How should the eForm be organized? 
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Once your ProviderLink facility administrator understands your needs, he or she will complete the 
process of designing, creating, testing, and implementing the form for your facility. After the eForm 
is implemented, it is available for use by anyone on your facility. 
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2. Sending Referrals 
One of the tasks you probably perform frequently is communicating about patient referrals.  
ProviderLink makes it easy for you to send referrals and reply to referral-related messages with 
online and fax-only facilities.  

A. Sending Referral Messages 

You can use an eForm as a referral tool and transmit it to a provider that can meet your patient’s 
needs. You send the eForm within a ProviderLink message. For details, see “Adding Documents to 
a Patient Record — eForms.” 

You can use ProviderLink to send referral messages to fax contacts as easily as to online contacts. 
Fax contacts will receive the ProviderLink message on their fax machines, and can respond using 
a bar-coded, fax-back cover page. When either type of contact replies, you will receive the 
response as an unread message attached to the patient record in your work list. 

To send a Referral Message: 
1. From the View Patient Information screen menu bar, click Send Message. The Create 

Message screen appears. For details, see "Sending a New Message through ProviderLink.” 

2. Select the recipient to whom you want to refer your patient. 

3. Attach the referral form and the necessary supporting documentation to include with your 
request. For details, see “To send a New Message through ProviderLink.” 

4. Enter your message Subject (e.g., “Referral”). 

5. Enter your Message text. 

6. Request a reply from your message recipients. 

7. Once you are satisfied with your message, click Send. 

B. Adding Documents to Patient Records 

ProviderLink enables you to store patient-related documents with each patient record. Any 
document that is sent to you online or faxed into the system can be added to a patient's record. 
You can also use the online eForms function in ProviderLink to create documents or you can copy 
information from clinical systems and paste it into a blank notes eForm. In addition, virtually any 
hard copy, paper document or any report you can print to a local printer can be added to a 
ProviderLink patient record and be sent in a message to another facility. 

To add a hard copy document to a Patient Record (Fax Attach): 
1. From the View Patient Information screen's menu bar, click Documents to view the 

Documents For Patient screen. 

2. On the menu bar, click Add Document  Add By Fax. The Add A Fax screen appears. 

3. Enter a document name that fits the type of document you are adding (e.g., Health & 
Physical). 

4. Click Print on the menu bar or the Print button. The system will generate a bar-coded 
cover page. 

5. Click Print on the menu bar to display the print options and print the cover page on your 
printer. 
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6. After the cover page prints, click Close on the menu bar to close the cover page and return 
to the Documents for Patient screen. 

7. Once the cover page prints, place it on top of the hard copy documents and fax the 
package to the number indicated on the cover page. After the fax sends successfully, the 
document will be listed on the Documents For Patient screen (this screen may need to be 
refreshed). 

8. You may click the document Name link to view the document you added. 

To add a document from another system to a Patient Record (Print Attach): 
1. From the View Patient Information screen's menu bar, click Documents to view the 

Documents For Patient screen. 

Note: A new version of the print application is available that allows you to print attach while 
not logged in to ProviderLink. Contact ProviderLink Customer Support for instructions on 
upgrading to the newest version. 

2. On the menu bar, click Add Document  Add By Print Job. The Add A Print Job pop-up 
window appears. 

3. Enter a document name that fits the type of document you are adding. 

4. Click the Print button. The Print Now screen appears and the system is ready to receive 
the document from another application. 

 

Figure 51. Print Now Screen 

5. Leaving the ProviderLink windows open, open the clinical system that contains the report 
and prepare to print it. 

6. Change the printer options to print the report using ProviderLink Virtual Printer. The 
document will spool to the printer and the ProviderLink Internet Gateway dialog box 
appears. 

7. After the status bar fills and the window displays the message “The send completed 
successfully,” click the Close button. 

8. Minimize or close the clinical system and return to ProviderLink. 

9. Close the Print Now window. The Documents For Patient screen will refresh and you 
should see the document you print-attached added the list. 

 
To add an Electronic Form (eForm) to a Patient Record: 

1. From the View Patient Information screen's menu bar, click Documents to view the 
Documents For Patient screen. 

2. On the menu bar, click eForms to view the available forms. 
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3. Select the appropriate Form Name. The system will display the form you selected. 

4. Complete the fields on the eForm, paying particular attention to the required fields as 
indicated by the red asterisks. 

5. After completing the form, click Save on the menu bar 

6. To have the system check to see if the form's required fields have been completed 
correctly, click Check on the menu bar. After checking the form, the system will display red 
text below the fields to show any errors. Fix the errors and check the form again. 

7. Once you are confident there are no errors on the form, click Save on the menu bar 

8. To close the form, click Save and Close on the menu bar 

C. Messages and Electronic Signatures 

Through ProviderLink, you have the ability to sign any document, whether added electronically or 
by fax attaching. Medicaid and most skilled facilities require a physician's signature for the approval 
request form to be valid. Depending on your workflows and practices, you can easily obtain and 
process these signatures for your ProviderLink documents. 

There are three ways to obtain signatures documents in ProviderLink: 

1. electronic signatures using a physician's user name and password 

2. sending the document to the physician's office with a bar-coded, fax-back cover page 

3. printing the form for signature and scanning it into ProviderLink with a bar-coded cover 
page.  

Once the form is signed, the signature is stored with the document, in the Documents list, and the 
form is tagged with the signature icon. When the signed form is transmitted to another facility, a 
copy of the original form is attached to the signed form. 

 

Electronic Signatures 

Because of modern technology and the desire to move to paperless processes, more and more 
healthcare organizations will accept electronic signatures on documents. In fact, most of these 
organizations have a written policy for electronic signature acceptance. You will need to verify your 
organization's electronic signature policy before using it to sign your ProviderLink documents. 

To electronically sign a document: 
1. From the menu bar of the form or document (screen) you wish to sign, click Signatures � 

Electronically Sign. The Add Signature screen appears.  

Note: If the Signatures option does not appear on the menu bar, you will need to Save the 
eForm first. 
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Figure 52. Electronically Sign a Document 

2. Select your name from the I am drop-down list and enter your Password. Click the Sign 
Document button. 

3. After you enter the correct password and submit the signature, the system will return you to 
the form or document you signed. Notice the menu bar now has fewer options. 

Figure 53. Document View after Electronic Signature 

 

 

To maintain the integrity of the electronic signature, ProviderLink locks the form as soon 
as it is signed or attached to a message. A locked form cannot be altered. When you 
need to change the data on the form, you must create a copy of the form with the “Save 
Copy” option on the menu bar and change the form data on the copy. If required, the 
new copy of the form will need to be signed. 

 

Printing the Document for Signature 

After completing a form, you may print the document and attach it to the patient's chart so that the 
physician can sign it. With the document, the system will generated a bar-coded cover page that is 
used to scan (fax) the signed document back into the patient's document list. The signed document 
is archived with the patient's record and can be transmitted to anyone who needs it.  

To print the document for signature: 
1. From the menu bar of the form or document you wish to sign, click Signatures  Print for 

Signature. The system will render the form as a PDF document and you will be asked to 
open it using your PDF reader.  

Note: If the Signatures option does not appear on the menu bar, you will need to Save the 
eForm first. 
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If you are using Windows XP with Service Pack 2 installed, Internet Explorer may display 
a security message at the top of the page: and prevent the file from appearing: 

If this occurs, simply click the yellow security message and, when the pop-up menu 
appears, choose to DOWNLOAD THE FILE. 

2. Click the Open button to open your PDF reader and view the file. The first page will be the 
bar-coded cover page, followed by the document itself. 

 

Figure 54. PC File Download Prompt 

3. Using your PDF reader's print function (usually File > Print), print all pages of the document 
on your desktop or network printer. 

4. Place the form where the physician can sign it. 

5. Once the form is signed, place the bar-coded cover page on top of the form and fax it to the 
number on the cover page. Once the ProviderLink system receives the fax and reads the 
bar code, the signed document will appear in the patient's documents list. 

 

Sending the Document to a Fax Contact for Signature 

If the physician is not in your facility to sign a document, you may use ProviderLink to send the 
document to a fax machine for signature. A fax-back cover page is provided so that, after the 
document is signed, the physician may fax it back to you through ProviderLink. When it arrives, the 
system will automatically route the signed document to the list of documents in the patient's record. 

To send the document to a Fax Contact for Signature: 
1. From the menu bar of the form or document for which you need a signature, click 

Signatures  Send for Signature.  
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Figure 55. Signatures Menu Options 

Note: If the Signatures option does not appear on the menu bar, you will need to Save the 
eForm first. 

2. The Create Message screen appears with the document already attached, the Subject is 
completed, and the Request a Reply and Create a Reminder Task check boxes are 
selected for you.  

3. Click the To Recipients drop-down arrow, and select the appropriate distribution list or 
mailbox for the office of the person whose signature you need. 

4. If the mailbox does not appear in the drop-down list, you can find it by clicking the Search 
button. The Facility Search pop-up window appears.  

5. Enter the search criteria and click Search. 

 

Figure 56. Facility Search 

6. The Search Results screen displays. Select the recipient from the list and click Save. 

7. The Create Message screen returns with the selected recipient in the To Recipients field. 

8. Enter an appropriate message Subject (e.g., “Signature Requested”). 
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The message subject is important for several reasons. First, the subject alerts the 
recipient to the potential importance of your message. Second, the message subject 
may assist the recipient to route your message to the person or department who can 
best complete your request. Also, ProviderLink uses your message subject as the link to 
open the message and displays it in the Message History. A descriptive subject should 
give users an idea of what the message contains without having to open the message 
itself. 

9. If necessary, enter a message in the Message field.  

Figure 57. Sending a Document for Signature 

10. When you are ready to send the message, click Send on the menu bar. The system will 
send the document for signature, create a reminder task (to remind you that you are waiting 
for a signature), and return you to the form screen. 

 

When the physician signs the document and faxes it back using the bar-coded, fax-back, 
cover page, ProviderLink will read the bar code and route the signed document to the 
patient's record. You will see an unread message for that patient appear on your work 
list. When the signed document arrives, the system will also mark the reminder task as 
complete. 

 

Processing Incoming Messages 

ProviderLink uses a single interface to send messages to both online and fax contacts. Once you 
send the message, ProviderLink sends the message to online contacts electronically and sends a 
fax transmission to fax contacts.  

Once they receive your request, either type of contact can reply to your message in the same way 
they received it. Online contacts can send their reply as an electronic message that will be 
attached to the corresponding patient message. Fax contacts will send their replies using the bar-
coded, fax-back cover page, which ProviderLink will convert to an electronic message and attach it 
to the corresponding patient record. In other words, replies to your requests will appear as unread 
messages attached to the patient record. 

You may access and read incoming messages using several methods, though it is usually 
recommended that you first navigate to the View Patient Information screen and then read the 
incoming messages. 
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To process Incoming Messages: 
1. From the Main Window List Summary, click Unread Messages to change to the Current 

View: Unread Message List. The list of unread messages is sorted in order by date and 
time received with the oldest message at the top. You may click any of the green column 
headers to re-sort the list. 

Figure 58. Unread Message List 

2. Click the Patient link to access the View Patient Information screen for the patient whose 
message you wish to read. 

3. In the Status section in the bottom left corner, click the Unread Messages link. The Unread 
Messages For Patient screen appears, showing you the list of unread messages, sorted by 
date and time, with the oldest message appearing first. 

 

You may navigate directly to the unread message by clicking the “Subject” link. 
However, the breadcrumb trail will only reflect the steps you took to read the message 
(Main Window > Read Message) and you will not be able to navigate to the associated 
patient's View Patient Information screen to access any of the patient's information 
without first returning to the Main Window.  

By navigating to the View Patient Information screen and then the Unread Messages For 
Patient screen, the patient's name is added to the breadcrumb trail (Main Window > 
Patient Name >Unread > Read Message). This enables you return to the View Patient 
Information screen to continue processing the patient's record. 

4. Click the Subject link of the message you wish to read. The message appears. The 
message header shows you who the message is from, the mailbox the message arrived 
through, the date and time the message arrived, whether or not the sender requested a 
reply (i.e., if an online contact), who read the message and when, the message text, and 
the names of the attached documents. 
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Figure 59. View Message 

5. Click the Attached Documents links to open the attachments. ProviderLink will open the 
attachment using the appropriate viewer. 

Figure 60. Attachment Viewer 

6. If necessary, print the document. 

a. To print the page you are viewing, click Print Page on the menu bar. The Print dialog 
box appears, allowing you to choose your printer. 

b. If you wish to print the entire document, click PDF Format on the menu bar.  

i. Depending on your operating system and PDF document reader (if installed), you 
may see a dialog box appear asking you whether you want to open or save the 
document. If the dialog box appears, click the Open button. 
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Figure 61. PC File Download Options 

ii. When the document opens in your PDF reader application, use the application's 
print instructions to print the document. 

iii. After the document prints, close the PDF reader and return to ProviderLink. 

7. When you are finished working with the attached documents, you may click Read Message 
in the breadcrumb trail to return to the message and send a reply. For details about replying 
to a message, see ”To Read and Reply to a Message.” 

D. Managing Your Work Lists 

Patient records are often moved through a workflow. Tasks and patients can be easily moved from 
one work list to another and so on to complete a workflow. When a patient is moved from one work 
list to another, all of the properties of that patient such as tasks, overdue items, etc., move to the 
new work list. So if a patient is moved, for example, from one unit to another in a hospital setting, 
all of that patient's open tasks and overdue items are automatically added to the new case 
manager's work lists. The new case manager can also see all related documents, forms, 
communication histories, authorizations, open communication requests, etc. 

After your portion of the patient's workflow is complete, you may remove a patient from a work list. 
The system will display a message if the patient record has any unread messages, incomplete 
tasks, or overdue items. If yours is the last work list linked to the patient, you will need to process 
all outstanding items (i.e., all unread messages and undone tasks) before removing the patient 
from your work list. 

To link another Work List to the Patient Record: 
1. From the View Patient Information screen, locate the Linked Work Lists section in the 

center of the screen. 
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Figure 62. Add a Linked Work List to a Patient 

2. Select the work list you wish to add from the All Available Work Lists list box and click the 
Add button. The chosen work list will be added to the Work Lists Linked to this Patient 
list box. 

3. On the menu bar, click Save. The system saves the patient record and adds it to the linked 
work list(s). 

To remove a Work List from the Patient Record: 
1. From the View Patient Information screen, locate the Linked Work Lists section in the 

center of the screen. 

2. Select the work list you wish to remove from the Work Lists Linked to this Patient list box 
and click the Remove button. The chosen work list will be removed from the Work Lists 
Linked to this Patient list box. 

3. On the menu bar, click Save. The system will check to see if there are any unread 
messages and incomplete tasks and, if there are, it will display an Open Items message. 
Review the message and click the Remove button. 

 

Figure 63. Patient’s Open Items 

4. If there are no other work lists linked to the patient record, the system will not allow you to 
remove the work lists and will display a message. Click the Continue button to return to the 
patient record and close the outstanding items. 

5. Once the patient is removed from the work list, the updated work list appears with the 
remaining patient records. 
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3. Requesting Medical Records and Other Patient Information 
ProviderLink makes it easy to electronically request patient-related documents and information 
from other facilities. You can send the requests to online and fax-only facilities. When the facility 
responds, the information is associated with the related patient’s record. 

You request medical records and other patient information by sending a ProviderLink message 
with a reply request to the required facilities. 

To Request Medical Records: 
1. Navigate to the desired Patient Information screen. For details, see “Viewing Patient 

Information.” Click Send Message.  

Figure 64. Send Message Menu Option 

2. The Create Message screen displays. Click Templates. Select a medical records request 
template from the list of available templates. Your template list may not match the screen 
shot. 

Figure 65. Templates Menu Option 

3. The Create Message screen displays, with the template contents included. 

Note: Your template may differ from the template example shown in the screen shot. 



Using ProviderLink in Your Daily Work 

   

Page 64

Figure 66. Message with Record Request Template 

4. Edit the information the template inserted into the Message field as required. 

5. Complete the message: 

 Select Recipients from the drop-down list, or click Search and search for the facility to 
which you want to send the request. 

 Select your From Mailbox from the drop-down list. 

 Enter a meaningful Subject, for example, “Patient Records Request.” 

6. Attach other documents, such as a signed patient consent form, as required: 

 Click Browse. A Documents window for the selected patient displays. 

 Select the documents you want to attach to the message. 

 In the Documents window, click Save. The Create Message screen displays. 

7. Select the Request a Reply and Include Fax-Back Cover Page check boxes. Select the 
Create a Reminder Task check box if you want to be reminded that you requested the 
information. 

8. When you are finished entering information on the Create Message screen, click Send.  

9. When the other facility replies to your request, it will appear as an unread message for the 
related patient. 

 

When a facility from which you requested medical records replies to your request using a 
ProviderLink message or a fax-back cover page, the response will appear as an unread message 
for the related patient. 
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If a fax-only facility responds without using the fax-back cover page your request 
message provided, the fax is not automatically associated with the patient. 

Such faxes are routed to your incoming fax folder, and must be processed. For details, 
see “To process an Incoming Fax.”  

Once the fax message is processed, you can read it as described in “To Read a 
Response to a Medical Records Request.” 

 

To Read a Response to a Medical Records Request: 
1. When a facility responds to your request for medical records, the response appears as an 

unread message for a patient. Click the Unread indicator for the selected patient. 

Figure 67. Unread Messages for Patient Link 

2. The View Unread Messages screen displays. Click the link of the document request 
message you want to read.  

Figure 68. View Unread Messages for Patient 

3. The View Message screen displays. 
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Figure 69. View Message for Patient 

4. Click the link(s) in the Attached Documents field. Follow your PC’s prompts to open or 
save the documents as required.  

5. If you want to view the information in the future, it is stored under History Items, available 
on the Patient Information screen.  

 

Other ProviderLink facilities may request medical records from your facility. When a medical 
records request is made, it will appear as an unread message for the related patient. If you receive 
such a request, you should read the message and respond to it. 

To Respond to a Message Requesting Medical Records:  
1. A request for documents appears as an unread message for a patient. From the Patient 

Information screen, click the number in the Unread column. 

Figure 70. Unread Messages Link 

2. The View Message screen displays. Click the link for the message to which you want to 
respond. 
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Figure 71. Select Unread Message 

3. The message displays. Click Reply. The message reply displays in the Create Message 
screen.  

4. Click Browse. The Documents for (patient name) pop-up window displays the available 
document folders for the selected patient. 

5. Navigate through the folder structure as required, select the requested documents, and 
click Save. 

6. The completed response displays in the Create Message screen. Add comments and select 
reply request options as required,  

Figure 72. Response to a Patient Information Request 

7. Click Send. Your response to the medical records request is sent to the requesting facility. 
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4. Managing Incoming Faxes (Virtual Fax Service) 
ProviderLink Virtual Fax Service (VFS) enables you to forward a fax line and receive all incoming 
faxes as imaged documents, which are processed and stored online. This provides a single 
interface and workflow for all your incoming fax and online communications.   

This section describes how faxes are processed in a message based workflow. Message based 
workflows are typical for new practices. If you want to learn about other options, refer to the 
ProviderLink Facility Administrator Manual. 

In ProviderLink, all incoming faxes to your facility are directed to an incoming fax messages folder 
then processed using the Document Viewer screen. The options and features on the Document 
Viewer screen are used to process incoming faxes by moving them to other folders or by attaching 
them to a message addressed to a mailbox within your facility. Options on the screen also allow a 
fax to be split into separate documents, renamed, and processed in a single step. 

You have the ability to add metadata information to a document. Once a document is stored with 
metadata, you can use the added information as search criteria to make it easier to find the 
document later. 

A. Processing Incoming Fax Messages  

When you receive fax messages that are not sent with a fax-back cover page, they cannot be 
automatically associated with a patient. Such messages need to be processed to add the fax 
document to a patient record and route the message to one of your facility's mailboxes and its 
associated work list.  

After the fax is processed, the person or department to which the fax is sent will see an unread 
message linked to the patient record. Since the fax document is attached to a patient record, it is 
then available to be attached to a message and sent. This workflow works best when the majority 
of incoming faxes are related to patients. 

To process an Incoming Fax: 
1. Be sure you are viewing the Incoming Fax Folder Main Window. For details, see “To 

process an Incoming Fax.” You will see a list of the faxes received with the oldest faxes on 
top. 

 

Your incoming fax folder may be named something other than “Incoming Fax Folder.” 

If you cannot identify the fax folder by reviewing the list available when you click the 
View link, see your facility administrator.  

 

Figure 73. Incoming Fax List 
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2. You will normally want to process the oldest document in the list. To view the oldest 
document, click the Get Next Fax button. The fax message will appear in the Document 
Viewer screen. 

Figure 74. View Fax in Document Viewer 

3. Above the fax document image, notice the image control links (i.e., Zoom In, Zoom Out, 
Rotate Left, Rotate Right, and Flip). If the fax message contains more than one page, you 
will see a numbered link for each page. 

4. ProviderLink will try to recognize the number from which the fax was sent and display the 
facility name in the required Originator field. If the Originator field is blank, the system 
does not yet have the fax number stored. If the Originator is not recognized, you will need 
to search for or create the fax contact. 

a. Click the Search button to the right of the Originator field. The Facility Search screen 
appears. 

b. Using the guidelines in the “To Send a Referral Message” section, search for the facility 
that sent the message. If the facility does not exist, your facility administrator can add it 
to the system. 

5. If there are multiple pages, view each page to determine if the message contains 
documents for more than one patient. 

a. If all the message pages relate to one patient record, accept the default “ALL” value in 
the Page(s) field. 

b. If the message contains pages for more than one patient, click the More button to add 
another set of routing fields. Then, enter the appropriate page number or page range 
(e.g., 1-3) in the Page(s) field. 

6. In the Document Name field, enter the type or name of the document.  

7. Search for the patient to associate the fax document. Click the Search button to the right of 
the Patient field. The Patient Lookup screen appears.  

8. Use the guidelines in the “To Create a New Patient Record” section to search for or create 
a new patient record. 

9. Choose the mailbox to route the fax document. 
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10. You may add additional information in the “metadata” fields. In this example, additional 
information can be added in the Status, Procedure Type, and Procedure Date fields. This 
will aid users when searching for this document. 

11. Once you have completed all of the required fields, you may choose how you wish to save 
the document(s). 

a. The “Remove document from fax queue” check box is selected for you automatically. 
This means that, when you choose one of the save options, the fax message will be 
removed from the list. Remove this check mark to leave the fax message in the queue. 

b. The “Save” button will process your routing options and return you to the same fax 
message for further processing. 

c. The “Save and Next button” will process your routing options, close the fax message, 
and open the next oldest one in the incoming fax folder. You will use this option most 
often when processing multiple fax messages. 

d. The “Save and Reply” button will process your routing options, close the fax message, 
and address an outgoing message to the sender of the fax. This enables you to request 
additional information from the fax originator. 

 
 



Using ProviderLink in Your Daily Work   

 

Page 71

Section 3 Summary 
After this demonstration of how the ProviderLink system assists you in your daily work, you should 
know how to: 

Transitioning from Paper to Electronic Communications 

 understand the benefits of transitioning to electronic communications 

 understand how ProviderLink supports your workflows 

 understand how to create and implement eForms 

Sending Referrals 

 send referral messages 

 access, complete, and process referral forms 

 add documents to patient records 

 print or send documents for signature 

 electronically sign documents 

 process incoming messages 

 manage your work lists 

Requesting Medical Records 

 send request messages 

 read responses to request messages 

 respond to medical record requests sent to your facility 

Virtual Fax Service 

 process incoming fax messages 
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Section IV - Appendices 

Appendix A – Troubleshooting ProviderLink Issues 
This section describes how to troubleshoot issues encountered while using ProviderLink. The table 
below lists common ProviderLink functions and respective issues, the steps you can take to 
resolve the issue, and some explanation of why the issue occurred. Most issues can be resolved 
using the instructions cited in this guide and the references to the appropriate sections are noted in 
the “Steps To Resolve” where appropriate. 

Function Issue Steps To Resolve What To Do Now 

Unable to log into 
ProviderLink 

The ProviderLink Login 
screen does not appear. 

Can you access other 
websites (e.g., 
google.com, etc.)? 

Yes – Contact the 
ProviderLink Help Desk to 
determine if there are any 
system issues. 
No – Contact your IT 
network staff to determine 
if your facility is having 
network or Internet issues.

Are you trying to 
access the correct web 
address? 

Be sure you are entering 
http://www.covisint.com
/web/guest/login-
healthcare into the web 

I forgot my password 
and/or user ID. 

Go to the Covisint login 
screen 
(http://www.covisint.c
om/web/guest/login-
healthcare) and click 
“Forgot your 
password?” or “Forgot 
your User ID?”

For password, enter your 
User ID and answer your 
challenge question to 
reset your password. 
For user ID, enter your 
email address, and your 
user ID will be emailed to 
you. 

I've been suspended. If you enter an incorrect 
password 5 times 
within 5 minutes, your 
Covisint-ProviderLink 
account will be locked 
due to an excessive 
number of invalid login 
attempts. 
Go to the Covisint login 
screen 
(http://www.covisint.c
om/web/guest/login-
healthcare) and click 
“Forgot your 
password?” 

In order to unlock your 
account, simply use your 
challenge question and 
answer to reset your 
password. Or your Facility 
Administrator can 
unsuspend your user 
account. 

Patient Records I can't find the patient Search for the patient ProviderLink saves patient 
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Function Issue Steps To Resolve What To Do Now 

record I was working 
with. 

record using the Patient 
Lookup feature. 

records indefinitely. 

Messaging I sent a message to a 
facility. How can I be 
sure it was received? 

Check the History 
Items for the patient. 

The History Items list 
records every incoming 
and outgoing message for 
the patient and whether or 
not a message is sent 
successfully. 

A message I was 
reading isn't in the 
Unread Messages list. 
Where can I find it? 

Check the History 
Items for the patient. 

Once you've read a 
message, it is removed 
from the Unread 
Messages list. 

Documents 
Management 

I faxed my document 20 
minutes ago and I don't 
see it in the patient's 
Documents list. 

Look for the document 
in your facility's 
Incoming Fax Folder. 
Route the document to 
the appropriate folder. 

When ProviderLink is not 
sure where to route a 
document, the system will 
route the document to the 
Incoming Fax Folder. 

I don't see the 
ProviderLink Virtual 
Printer in my list of 
printers. 

You must install the 
ProviderLink Virtual 
Print Driver before you 
can print attach any 
documents.  

The ProviderLink Virtual 
Print Driver can be 
downloaded and installed 
from the Help menu on 
the Main Window. Go to 
Help > Download Print 
Application. 

The ProviderLink Printer 
gives me an error 
message: “Please attach 
a case within 
ProviderLink before 
attempting to print.”  
 

Print attach a document 
into a ProviderLink 
patient record. 
Also, contact 
ProviderLink Customer 
Support for newest 
version of the Virtual 
Print Driver. 

You must first start in the 
patient's record and 
choose to add a 
document by print job 
before printing using the 
ProviderLink Virtual 
Printer. 
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Appendix B – ProviderLink Quick Reference Guide 
 

ProviderLink Quick Reference Guide 

To login to ProviderLink: 

1. In the IE window Address bar, type http://www.covisint.com/web/guest/login-healthcare 
and press the Enter key. The Covisint login screen will appear. 

2. Enter your User ID and Password. 

3. Click Login. The Covisint Healthcare home page displays. In the left-hand menu, under 
Secured Applications, click ProviderLink to launch the application, which opens in a new 
window. 

To unsuspend Your ProviderLink Account: 

If you try to log in and fail 5 times in 5 minutes, the system will suspend your user account and you 
will need to reset your password. In order to unlock your account, simply use your challenge 
question and answer. This will automatically unlock your account. 

1. From the http://www.covisint.com/web/guest/login-healthcare page, click “Forgot your 
password?.”  

a. The screen expands displaying a field to enter your User ID and then click Submit. The 
Reset Password screen displays. 

b. Enter the answer to your challenge question in the Challenge Answer field and click 
Submit. 

c. Upon successful submission, the first half of the password displays on the screen, while 
the second half is sent to email address you submitted during the registration process. 

2. Alternatively, you may contact your facility Security Administrator to request that he/she 
perform the password reset and unlock your account. 
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ProviderLink Quick Reference Guide 

To check ProviderLink for and read Incoming Messages: 

1. Once logged into the system and viewing the Main Window screen, click the View link in the 
top right corner. 

2. Click the View drop-down arrow and choose your Work List.  

3. Click Submit to display your Work List. The Main Window screen will appear. 

4. When viewing your work list, the number of Unread Messages will appear at the top of the 
screen and in the Unread column in the patient list. Clicking either of these numbers will 
display the message list. 

5. To read a message, click the patient's name link in the Patient column. 

6. When the View Patient Information screen appears, click the Unread Messages link in the 
Status section in the bottom right corner. 

7. When the Unread Messages for Patient screen appears, you may read a message by clicking 
the Subject link. The message will appear on the Read Message screen. 

8. From the menu bar, you may Reply, Forward, Mark the message Unread, view information 
about the sender Contact, and Print the message. 

9. If there are any Attached Documents, you may click the links to read the attachments. 

10. To go back and read more unread messages, you may click on Unread Messages or the 
patient's name in the breadcrumb trail at the top of the screen. 
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ProviderLink Quick Reference Guide 

To process an Incoming Fax Message: 

1. From the Default Incoming Fax Folder screen, click the Get Next Fax button. The first page of 
the fax message appears. 

2. Once you determine which provider the message is from, click the Originator drop-down list to 
see if the provider appears. If so, select the provider. 

3. If the provider is not in the Originator list, click the Search button to bring up the Facility 
Search window. 

4. Enter the necessary criteria to search for the provider and click Search. The system will 
display the search results based on the criteria you specified. If the provider you are searching 
for does not appear, modify the search criteria and repeat the search. 

5. If the provider still does not appear, you may need to create the facility. 
See “To Create a New Fax-Only Facility.” 

6. Identify the type of document and enter it into the Document Name field. 

7. Next to the Patient Name field, click Search. Use the Patient Lookup window to find the patient 
record. If no patient record exists, you may need to create a new one. 
See “To Create a New Patient Record.” 

8. Click the Mailbox drop-down arrow to display the list of mailboxes to route the message. 
Choose the appropriate recipient's mailbox. 

9. For multi-page fax messages, click the page numbers to check if multiple messages were sent 
in the same transmission. If so, you will need to split the message and route each part 
separately. To set up the split, click the More button to bring up a new row for each message 
part. The Document Name, patient Name, and Mailbox will carry forward to each new row and 
may need to be changed. 

10. In the Pages field, enter the pages to send for each message part. For all pages, accept the 
default “All” value.  

11. Once you have filled in all of the fields for each message part, make sure Remove document 
from the fax queue is selected and click the Save and Next button to pull up the next fax 
message. 

To create a New Patient Record: 

1. From the Patient Search Results window, click New on the menu bar. The Add/Edit Patient 
Information screen appears. 

2. Fill in, as a minimum, the patient's Last Name, First Name, and Birthdate in the respective 
required fields. You do not have to select a work list. 

3. Click Save. The patient's name will appear in the Patient field. 

Note: This also works from the Main Window screen (New > Patient). 
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ProviderLink Quick Reference Guide 

To create a New Fax-Only Facility: 

1. From the Main Window, click Lookup > Facility. The Search window displays. Click New on the 
menu bar. The Add/Edit Fax Facility Information screen appears. 

2. Enter name of the provider in the Fax Facility Name field, which is the only required field. 

3. If needed, enter the: Main Phone Number; City; State/Province; Zip; and County. 

4. Choose the type of provider from the All Facility Types list box and click Select. There may 
be more than one applicable provider type. If you have added a facility type and want to 
remove it, you may highlight the facility type and click Unselect. 

5. When you have checked your entries for accuracy, click Save.  

To add Documents to a Patient Record with the Virtual Printer: 

1. Start from the patient's View Patient Information screen, and click Documents on the menu 
bar. 

2. When the Documents screen appears, click Add Document on the menu bar, and then select 
Add By Print Job from the drop-down list. 

3. When the Add a Print Job window appears, enter a name in the required Document Name 
field. 

4. Click Print. The Print Now window appears and the system is ready to receive the document. 

5. Without logging out of ProviderLink, open the document you wish to print.  

6. For most applications, click File>Print, select “ProviderLink Virtual Printer” from the list of 
printers, and click Print.. 

7. The ProviderLink Internet Gateway window will appear and the document will be sent to the 
patient record. When you see “The send completed successfully” message, click the Close 
button. 

8. Minimize the document window to get back to the ProviderLink Print Now window and click 
Close. 

9. Navigate back to the ProviderLink window (look for the “Documents Management” button on 
the task bar) and the document will appear in the list. 

10. You may click the Document Name link to ensure the authorization was added successfully. 
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ProviderLink Quick Reference Guide 

To add a Paper (hard copy) Document to a Patient Record 

1. Start from the patient's View Patient Information screen, and click Documents from the menu 
bar. 

2. When the Documents screen appears, click Add Document on the menu bar and then select 
Add By Fax from the drop-down list. 

3. When the Add a Fax screen appears, type a Document Name and click Print.  

4. You will see a bar-coded cover page appear. Click Print from the menu bar and print the 
document to your printer. 

5. Take the bar-coded cover page, PUT IT IN FRONT of the document you wish to add, and fax it 
to the number on the cover page. After the fax sends the document to ProviderLink, the 
document will appear in the patient's list of documents (i.e. on the Documents screen). 

Note: It may take a few moments for the document to appear in the patient's documents list, 
depending on the number of pages in the fax message.

To send a Message through ProviderLink 

1. Start from the patient's View Patient Information screen, and click Send Message from the 
menu bar. The Create Message screen appears. 

2. Select the provider name from the To Recipients drop-down list. If the provider does not 
appear in the list, you may search for the facility in the same way as in “To Process an 
Incoming Fax Message” steps 3-5. 

3. The From Mailbox should already be set for you.  

4. Click the Browse button to select the documents you wish to attach.
Note: When including an attachment to a message to a fax-only facility, only documents saved 
as PDF or TIF files (i.e., faxes) can be sent. If other file types are attached (e.g., Word doc, text 
file, Excel spreadsheet, etc.), a warning will display stating that this file type cannot be sent to a 
fax-only facility.  

5. Enter an appropriate Subject, which will appear on the fax cover page. For example, “OP 
Requisition.” 

6. You may enter a Message that will appear on the fax cover page. You may also choose to use 
a Template to enter a standardized Message. 

7. If you want the recipient to reply, click the Request a Reply check box. You may want to 
deselect the Create a Reminder Task check box if you do not wish to be reminded you are 
requesting a response. 

8. Click Send. The message will be delivered to the recipients you specified. 
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ProviderLink Quick Reference Guide 

To view another Work List 

1. Start from the Main Window screen and click the View link in the top right corner (it will say 
“View” followed by the work list name). The Choose Work List View screen will appear. 

2. Click the View drop-down arrow to display the list of work lists and folders available for your 
organization. 

3. Select the work list you wish to view. 

4. Click the Submit button to view the work list. 

To set a Reminder Task on a Patient Record 

1. Start from the patient's View Patient Information screen. 

2. In the bottom left corner in the Status section, click Tasks. The Tasks screen appears. 

3. On the menu bar, click New. The Add/Edit Scheduled Task screen appears. 

4. Enter the task Description and Due Date. You may use the calendar pop-up window by 
clicking the calendar icon . 

5. In the Non-viewable Comments field, you may enter any special instructions or other 
comments regarding this task.  

6. Click Save to save the task and set the reminder. You will return to the Tasks screen. 

To complete or select (remove) a Task 

1. Start from the patient's View Patient Information screen. 

2. In the bottom left corner in the Status section, click Tasks. The Tasks screen appears. 

3. Find the task you wish to complete and click the Description link. The Add/Edit Scheduled 
Task screen appears for that task. 

a. To COMPLETE the task, click Complete on the menu bar and then select either With 
Notes or Without Notes. If you chose to complete the task with notes, enter the notes in 
the Viewable Comments field and click the Complete Task button. 

b. To DELETE the task, click Delete on the menu bar and then select either With Notes or 
Without Notes. If you chose to delete the task with notes, enter the notes in the Viewable 
Comments field and click the Delete Task button. 

4. After completing or deleting the task, you will return to the Tasks screen. 
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ProviderLink Quick Reference Guide 

To view a Patient's Message History and Audit Trail 

1. Start from the patient's View Patient Information screen and click History Items to view the 
Message History screen and every message sent or received relating to that patient. 

2. To view a message, click the message Subject link. 

3. Clicking History in the breadcrumb trail will take you back to the Message History screen. 

4. For a more detailed record of the patient record history, click Audit Trail on the menu bar. This 
will show you a detailed history of virtually every activity regarding the patient record including 
what occurred, when it occurred, and the associated user name and patient record.  

TToo  rreemmoovvee  aa  PPaattiieenntt  RReeccoorrdd  ffrroomm yyoouurr WWoorrkk LLiisstt:: 

1. Start from the patient's View Patient Information screen in the Linked Work Lists section. 

2. In the Work Lists Linked To This Patient list, select your work list name and click Remove. 

3. When the system asks you to confirm, click Remove.  

4. The system will display your updated work list with the patient record removed. 

To log out of ProviderLink: 

1. From almost any screen, click Logout on the menu bar. 

2. After you have successfully logged out, you may close the browser window. 

Note: Be sure to log out before you close the browser window to prevent any unauthorized access 
to protected healthcare information. 

To get Help: 

1. Check the online help – click Help on the menu bar. 

2. Read the User Training Manual. 

3. Contact YOUR facility administrator.  

 
 


